
On October 4, the Board of Selectmen approved 
the extension of the option to lease  4.8 acres of 
land to Wilton Commons until December 8, 
2011.  With the downturn in the economy, fund-
ing has been difficult to obtain.  However, Wilton 
Commons has made significant progress in the 
past three months toward meeting the conditions 
in the option agreement.  We expect to start the 
closing process for funding with the state agen-
cies and the tax credit investor as we approach 
the current deadline of December 8, 2010. 
 
In addition to approval by the Selectmen, the one
-year option extension requires approval by a 
Special Town Meeting which will be held on 
Tuesday, November 30, 7:30 p.m., at Middle-
brook School.  There will be no Saturday vote.  
Please attend and vote ―Yes‖ for the extension of 

Lizabeth Doty, Senior Activities Coordinator, Town of Wilton 
Comstock Community Center, 180 School Road, Wilton, CT  06897    203-834-6240 

 Veterans Memorial to be Dedicated November 11 
On Thursday, November 11, at 10:00 a.m., the 
Veterans Memorial Green, honoring all Wilto-
nians who have given their lives in service to 
their country, will be dedicated 
at the intersection of Old 
Ridgefield Road and Center 
Street.  Veterans will meet at 
the library and march to the 
Memorial for the Veterans Day 
Ceremony and the Veterans 
Memorial Green Dedication.  
The ceremony will conclude at 
11:00 a.m. with raising of the 
flag and playing of taps. 
 
Since the French and Indian War, Wilton men 
and women have fought in our country’s wars, 
bringing honor to our town as they did.  This 
memorial will provide a central place to pay 
homage to their sacrifice. 
 
The memorial consists of six granite monu-
ments inscribed with the names of Wilton’s 

honored war dead, a bluestone plaza, and a 
lighted flagpole from which the  American flag 
will fly day and night. 

 
Members of the Veterans Me-
morial Green Committee are 
Chairman Bill Brennan, Tom 
Briody, Ken Dartley, Don 
Hazzard, Ann Klotz, Don 
Klotz (deceased), Jack Ma-
jesky, Carol Russell, and Bing 
Ventres; Tom Thurkettle, Pro-
ject Manager; Bob Faesy, 
Kevin Quinlan, and Richard 
Vail, Architects; Richard Kent, 

Landscape Architect. 
 
This endeavor has been a private-public col-
laboration.  You may make a donation on the 
Town website www.wiltonct.org or by check 
payable to the Town of Wilton.  The public is 
encouraged to attend this event honoring our 
service men and women. 

the Option Agreement until December 8, 2011.  
Be sure to have personal identification with you. 
 
Dial-A-Ride will provide service to Middlebrook 
School on November 30 for the Special Town 
Meeting.  In addition Lauren Hughes, Coordina-
tor of Senior Services, will match individual driv-
ers with those who need a ride.  Call Lauren at 
203-834-6238 if you can drive others or you 
need a ride yourself. 
 
The Wilton Commons Board has worked dili-
gently for ten years to get where we are today. 
We need your support by attending the meeting 
and voting "YES." 
 

George Ciaccio, Chairman, Wilton Commons 

WILTON COMMONS VOTE ON NOVEMBER 30 
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Memory Screening on November 1 and 16 
On Monday, November 1, Visiting Nurse & Hospice of 
Fairfield County and the Wilton Senior Center will 
sponsor free one-on-one, confidential memory 
screening from 9:30 a.m. to 11:30 a.m. at the Wilton 
Senior Center.  Screenings will take place by appoint-
ment only.  For more information or to make an ap-
pointment, contact Jeanette Graham, Life Care Coor-
dinator at Visiting Nurse & Hospice, at 203-762-8958 
ext. 249.   Another opportunity for memory screening 
will take place on Tuesday, November 16, at Laurel 
Ridge Health Care Center, 642 Danbury Road, 
Ridgefield, from 11 a.m. to 2 p.m.  To schedule your 
appointment or for more information, call Laurel 
Ridge at 203-438-8226.  These confidential memory 
screenings are offered free of charge as a community 
service. 
 
Why is memory screening important? 
 
Memory screening is a first step toward identifying  
Alzheimer’s disease, related dementia, and other 
conditions that cause memory loss.  Memory screen-
ing may put your fears to rest when results turn out 
normal.  A normal memory screening score also es-
tablishes a baseline for future comparison.  The re-

 
 
 
 
 
 
 

Perry Ebel will be the speaker at the November 
20 meeting of the Hearing Loss Association of 
America, Southwestern CT Chapter.  His topic 
will be ―Innovative Assistive Hearing Devices 
for Those with Hearing Loss‖. 
 
The mission of the association is ―We open the 
world of communication to people with hearing 
loss, their family, and friends by providing infor-
mation, education, support and advocacy.‖  
The meetings, held at the United Covenant 
Church, 68 Westport Rd., Wilton, are free and 
open to the public.  For information contact 
Alan Gould at 203-762-8269. 

sults of the memory screening do not represent a 
diagnosis of any particular illness.  Screening does 
not replace consultation with a qualified healthcare 
professional.   
 
Memory may be affected by a number of factors, 
including stress, lack of sleep, Alzheimer’s disease,   
vascular dementia, vitamin deficiencies, depression, 
and thyroid problems.  Some conditions are reversi-
ble.  In general, the earlier the diagnosis, the easier 
it is to treat.  Early recognition of mild cognitive im-
pairment provides an opportunity for healthcare pro-
fessionals to treat the condition and possibly slow 
the decline in memory and other functions. 
 
A memory screening is a simple, safe evaluation 
tool that takes five to ten minutes to administer.  It 
consists of a series of questions and/or tasks de-
signed to test memory, language skills, thinking abil-
ity and other intellectual functions. 
 
Results of the memory screenings are confidential.  
Ask for a copy of the screening results to bring to 
your healthcare professional. 

 

BLOOD PRESSURE SCREENINGS 
 

Complimentary and open to the public. 
Sponsored by Visiting Nurse & Hospice  

 
Wilton Senior Center, 11 a.m. to noon 

Thursdays, November 4 and December 2 
 

Village Market, 12:30 p.m. to 2 p.m. 
Tuesdays, November 23 and December 28 

 
Wilton Family Y, 9 a.m. to 10:30 a.m. 

Wednesdays, November 17 and December 15 
 

Ogden House (residents only) 
9:30 a.m. to 11 a.m. 

Fridays, November 5 and 19 
Fridays, December 3 and 17 



UPCOMING FLU CLINICS 
Flu vaccine clinics are open to anyone age three 
years or older. No appointment is necessary.  Cost 
for flu vaccine is $38. Medicare, Anthem, Aetna, 
cash or check will be accepted. Pneumonia vaccine 
is also available for persons age 65 and older who 
have not received the vaccine since reaching age 
65. Cost is $60. Pneumonia vaccine is billable to 
Medicare Part B.  Visiting Nurse & Hospice clinics 
will take place on: 
 

Saturday, November 6 
Wilton YMCA 

9:00 a.m. to 11:00 a.m. 
 

Friday, November 26 (day after Thanksgiving) 
Wilton Library 

10:30 a.m. to 1:30 p.m. 
 
For more information, call the Flu Info Line at 203 
834-6341 ext 444 or visit www.visitingnurse.net. 
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ITNCoastalCT 
 
ITNCoastalCT™ is dedicated to keeping seniors 
active and engaged.  Recent studies have shown 
that when seniors stop driving, they go to 15% 
fewer doctor trips, 59% fewer shopping/entertaining 
outings and 65% fewer social events.  United Way 
of Coastal Fairfield County grant funds will go to-
ward this transportation service, which is 24 
hours a day, 7 days a week, 365 days a year for 
any reason.  The arm-through-arm, door-through-
door service will be available to up to 36,000 sen-
iors in the six-town region of Westport, Weston, 
Norwalk, Fairfield, Wilton, and Easton.  All drivers 
are background-checked and trained to assist rid-
ers with packages and walkers. 
 
ITNCoastalCT will begin 
service with a ―soft start‖ on 
November 8, 9, and 10. 
 
Information packets are 
available at the Senior Cen-
ter.  Call for more information:  203-834-6240. 

MEDICARE “REPS” ARE COMING! 
MEDICARE  PART D INFORMATION APPOINTMENTS 

On Thursday, November 18, representatives from 
the Southwestern Connecticut Agency on Aging 
will be at the Senior Center meeting with individu-
als regarding the Medicare Part D prescription drug 
program.  Appointments between 10 a.m. and 1 
p.m. are available for any Medicare beneficiary 
who has Medicare Part A or Part B or both.  No-
vember is the time to get the help you need to 
choose or change your prescription drug plan.  
Please call Sharon Powers at 203-834-6238 to 
schedule an appointment. 

This is your window of opportunity to enroll in or 
change your Medicare Part D prescription drug 
coverage program.  The Annual Enrollment pe-
riod is from November 15 to December 31.  En-
rollment in Part D is optional, but if you do not sign 
up when you are first eligible and change your 
mind later, you may have to pay a penalty of higher 
premium.  There are exceptions.  When you first 
become eligible for Medicare, you may enroll in a 
Medicare Prescription Drug Plan the first day you 
become eligible for Part A or part B.  You may also 
enroll in a Medicare Prescription Drug Plan when 
you first become eligible for low-income subsidy 
(Extra Help). 

Cholesterol Screening 
Visiting Nurse & Hospice 

761 Main Avenue, Suite 114, Norwalk 
 

Tuesday, November 9 
8:30 a.m. to 11:30 a.m. 

 
Includes total cholesterol, HDL, LDL, triglycerides 
and glucose, blood pressure, Body Mass Index cal-
culation and health counseling session with RN.  
Fasting recommended, but not necessary.  By ap-
pointment only.  Please call 203-762-8958 ext. 221. 
Cost:  $25, cash or check. 

PARKS AND REC TRIPS 
 

November 19 

Pequot Museum/Foxwoods Casino 
 

December 6 

Newport Mansions, Newport, RI 
 

December 9 

New York On-Your-Own 
 

www.wiltonparksandrec.org 
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Ogden House Activities 
 

Sandra Bacher is teaching Watercolor Art.  Classes 
take place on Tuesdays from 8:45 a.m. to 11:45 
a.m. in the activities room.  November 30 to January 
4.  $20 for Ogden House residents; $27 for non-
residents. 
 
Liz Wendell is teaching gentle chair yoga on Tues-
days from 2:00 p.m. to 3:00 p.m.  The exercises fo-
cus on breathing and movement of the body while 
integrating mind and body through meditation.  $3 
per class.  New students are always welcome. 

All three polling places will be open on Tuesday, No-
vember 2, from 6 a.m. to 8 p.m. for Wilton voters to 
cast their ballots in this year's important State/
Federal election.  Your ballot will include all state-
wide Connecticut offices (Governor, Lieutenant Gov-
ernor, and Attorney General), U.S. Senator, U.S. 
Representative, State Senator, and State Represen-
tative.  Polling places are Wilton High School Clune 
Center, Driscoll Gym, and Middlebrook Gym.  Ab-
sentee ballots are available NOW from Bettye 
Ragognetti, your Town Clerk. 
 
If you have questions, contact your Registrars of 
Voters, Tina Gardner or Carole Young-Kleinfeld at 
203-563-0111.  The Wilton website has a handy 
Voter Info Look-Up site at www.wiltonct.org to check 
your polling place. 

Local Election News 

Rising Stars Perform at the 
―Arts at St. Matthew’s‖ 

 

Houston Grand Opera mezzo-soprano Faith 
Sherman and Pittsburgh Opera baritone Dan 
Kempson will reunite in a joint recital at St. Mat-
thew’s on Sunday, November 21, at 4 p.m.     
Both former Wiltonians and graduates of Wilton 
High School, these two homegrown singers are 
rising stars in the opera world. 
 
Dan Kempson grew up singing with St. Mat-
thew’s choirs and the Wilton High School music 
programs. Reviews of his performances with 
opera companies from coast to coast praise his 
rich, ringing tone and resonant voice, as well as 
his onstage ease and enchanting manner. 
 
Faith Sherman, who participated in the Wilton 
Presbyterian Church and Wilton High School 
music programs, now resides in Texas. She 
performs all over the country and Europe to 
rave reviews for her excellent, expressive 
mezzo and her passion and poise on stage. 
 
You won’t want to miss these two outstanding 
young musicians when they ―Come Home to 
Wilton‖ and to the ―Arts at St. Matthew’s.‖ 
 
Tickets available at St Matthew’s office or call 
203-762-7400 to reserve your seat. 
Adults:  $20 
Patrons:  $40 (preferred seating) 
Students:  $5 

SENIOR CENTER LUNCH PROGRAMS 
12:45 to 1:25 p.m. at the Ogden House 

 
November 3, The Hoot Owls 
November 10, Griffin Liewa, RN, Director of Nursing 
Services at Laurel Ridge Health Care Center in 
Ridgefield, will talk about fall prevention and senior 
safety. 
December 1, Gentleman Songsters 
December 8, The Treblemakers 
December 15, The Middlebrook Singers 
 
Local religious and civic organization teams prepare 
a delicious lunch each Wednesday for Wilton sen-
iors.  The luncheon is open to all Wilton seniors and 
takes place at the Ogden House, 100 River Road.  
Lunch ($3) begins at noon.  Reservations:  203-834-
6240. 

 
LUNCH AT ST. MATTHEW CHURCH 

 
St. Matthew Church has added a December 2 
Lunch to its program this year.  Cathy Pierce, Direc-
tor of Wilton Social Services will be the guest 
speaker.  Ms. Pierce will speak about services avail-
able through the town’s Social Service Department.   
 
Lunch is served at noon; donation, $3.  Call St. Mat-
thew Church office for reservations:  203-762-7200. 

 

http://www.wiltonct.org


  

BAPTIST CHURCH THANKSGIVING LUNCH 
The Wilton Baptist Church, 254 Danbury Road, will  
treat the town’s senior citizens to a bountiful 
Thanksgiving luncheon on 
Wednesday, November 17.  Be-
ginning at 11:30 a.m., with hot 
cider, this will be the thirty-fourth 
year of the generous gift at no 
cost to Wilton seniors.  Erik Fort-
meyer  will be organizing the affair 
along with help from community  church members.  
Reservations:  Call the Senior Center at 203-834-
6240 by Monday, November 15.  Do not call the 
Baptist Church. 
 
PARKS AND REC THANKSGIVING LUNCH 
The Parks and Rec Department will host a Thanks-
giving luncheon on Friday, November 12, at noon 
at the Comstock Community Center.  The cost is 
$5.  Reservations:  203-834-6234. 
 
CHRISTMAS HOLIDAY CELEBRATIONS 
On Wednesday, December 15, Captain Karl Dolnier 
and Wilton Career Fire Fighters Local 2233 will  
serve a turkey dinner with all the trimmings to sen-
iors at the weekly Ogden House luncheon.  This 
wonderful tradition began in 1985 as a way for the 
fire fighters to thank seniors for their years of sup-
port.  Volunteers from Our Lady of Fatima Church, 
under the direction of Ed Raposa, will prepare the 
meal compliments of the fire fighters.  Lunch is 
served at noon; guests are encouraged to come 
early to socialize.  The Middlebrook Singers and 
Middlemen under the direction of Janet Nobles, 
Jana Janeway, and Jennifer Ginsberg will again 
provide the entertainment.  Middlebrook’s Student 
Council, coordinated by Tim Ley, will treat the par-
ticipants to homemade delights. 
Reservations:  203-834-6240. 
 
PARKS AND REC HOLIDAY LUNCH 

The Parks and Rec Department will 
sponsor a Holiday Luncheon at Com-
stock Community Center on Friday, 
December 10, noon to 1:30 p.m.  The 
lunch and entertainment are $5.  Res-
ervations:  203-834-6234. 
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Seminar with Sonia 
 

To awaken the sleeping teacher in-
herent in all of us, learn the simple 
steps of self-hypnosis with Sonia 
Katz.  In a recent interview, Ms. Katz 
explained:  ―It is a skill that can be 
easily understood and implemented.  
I have used this knowledge for over 
40 years and want to share this with 
you.  Join me for a workshop of fun and relaxation 
whatever your age or experience.  This is a positive 
step to improving the quality of your life.  After all, 
hypnosis is really focused concentration.‖ 
 
Ms. Katz studied hypnosis with Dr. Brian Weiss, 
author of Many Lives, Many Masters.  Ms. Katz will 
teach how to achieve relaxation through breathing 
techniques, guided meditation, and position, and 
how to plant the proper suggestions in the uncon-
scious mind in order to achieve goals. 
 
When:  Thursdays, November 4, 11, 18, at 2 p.m. 
Where:  Senior Center 
Fee:  $5 per class 

AVAILABLE FOR MEETINGS 
 
The Trackside Center, located at 15 
Station Road just off Route 7,  is avail-
able for daytime and evening meetings 
for groups, large and small.  Daytime 
meetings for Wilton groups and commit-
t e e s  a r e  a v a i l a b l e  f r e e  o f 
charge.  Groups can meet in a confer-
ence-room setting for up to 14 people, in 
a relaxed living room setting for up to 
20, or for large groups up to 120 in the 
barn setting.  The kitchen is available for 
warming and preparing foods, and the 
coffee pot is always on!  For more infor-
mation or to book a meeting, please call 
Trackside at 203-834-2888. 
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NOVEMBER 2010 
Monday Tuesday Wednesday Thursday Friday 

1 

9:30-11:30  Mem-
ory Screening at 

Comstock 

10:30 Line Dancing 

11:30 Coffee and... 

12:30 Play Reading 
with Andrea 

2 

Election Day 

11:00  Yoga 

12:00  Garden Club 
Lunch and Activity 

2:00  Chair Yoga OH 

3 

10:00  Tai Chi 

10:00  Comstock Writ-
ers 

12:00 Lunch OH 

Guest:  Hoot Owls 

12:00 Duplicate 
Bridge 

 

4 

10:00 Yoga 
11-12 Blood Pressure 
Screening 
12:00 Lunch 

12:45  Bingo 

2:00  Seminar with Sonia 

6:00 Life is not a Specta-
tor Sport! G 

5 

9:30-11 Blood Pres-
sure Screening OH 

10:00  Jewelry 

12:00  Bridge 

1:30-3  Free Swim Y 

8  

10:30 Line Dancing 

11:30 Coffee and... 

 

 

9 

8:30-11:30 Cholesterol 
Screening VNH 

9:30  Intro to Computer 
Fundamentals 

11 Yoga 

1 Comstock Knitters 
and Crafters 

2:00  Chair Yoga OH 

10 

10:00  Tai Chi 

11:00-1:00  RSVP 
Holiday Boutique OH 

12:00 Lunch OH 

Guest:  Griffin Liewa 
on Fall Prevention and 
Senior Safety 

 

11 

10:00  Dedication of 

Veterans Memorial 

10:00  Yoga 
12 Lunch 

12:45  Bingo 

2:00  Seminar with Sonia 

5:30 Social Services 
Commission at Trackside 

6:00 A Stroke is not Par 
for the Course! G 

12 

9:30  Intro to Com-
puter Fundamentals 

12:00  Parks and Rec 
Thanksgiving Lunch 

12 Bridge 

1:30-3  Free Swim for 
Seniors Y 

15 

10:30 Line Dancing 

11:30 Coffee and... 

 

16 

11:00-2:00  Memory 
Screening by ap-
pointment at Laurel 

Ridge 

9:30  Graphics 

11:00  Yoga 

12:00 Duplicate Bridge 

2:00  Chair Yoga OH 

17 

9:00-10:30 Blood 
Pressure Screening Y 
10:00  Tai Chi 
10:00  Comstock Writ-
ers 

11:30  Thanksgiving 
Lunch at the Baptist 
Church 

18 

10:00  Yoga 
10:00-1:00 Medicare Part 
D consultations by ap-
pointment 
12:00  Complimentary 
Lunch WM 

2:00  Seminar 

with Sonia 

19  Pequot Museum/

Foxwoods Trip 

9:30-11 Blood Pres-
sure Screening OH 

9:30  Graphics 
12 Bridge 

1:30-3  Free Swim for 
Seniors Y 

22 

10:30 Line Dancing 

11:30 Coffee and... 

1:00 Comstock 
Knitters and Craf-
ters 

23 

11:00  Yoga 

11:00 Book Discussion 
with Ray Rauth 

12:00 Lunch 

12:30-2 Blood Pres-
sure Screening VM 

2:00  Chair Yoga OH 

24 

10:00 Tai Chi 

No Lunch at Ogden 
House 

25 

Thanksgiving Day 

Senior Center Closed 

26 

Senior Center 

Closed 

 

10:30-1:30 

Flu Clinic WL 

29 

10:30 Line Dancing 

11:30 Coffee and... 

30 

8:45 Water Color OH 

11:00  Yoga 

2:00  Chair Yoga OH 

7:30 Wilton Commons 
Special Town Meeting 
at Middlebrook School 

 

OH Ogden House 100 River Road 203-762-8035 

Y Wilton Family Y 404 Danbury Road 203-762-8384 

WL Wilton Library 137 Old Ridgefield Rd. 203-762-3950 
G The Greens  435 Danbury Road 203-761-1191 

WM Wilton Meadows 439 Danbury Road 203-834-0199 

VM Village Market Old Ridgefield Road 203-762-7283 
VNH Visiting Nurse & Hospice 761 Main Ave., Norwalk 203-762-8958 

LR Laurel Ridge Health Care 642 Danbury Rd., Rdgfld 203-438-8226 

All activities are held at the Senior Center unless otherwise noted. 

Flu Clinic Nov. 6, 9-11 a.m., Y 

Hearing Association Meeting, Nov. 20 

St. Matthew’s Concert, Nov. 21 
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DECEMBER 2010 
Monday Tuesday Wednesday Thursday Friday 

1  
9:30 RSVP OH 
10:00  Tai Chi 

10:00 Comstock Writers 

12:00  Lunch OH 
Guest:  Gentlemen Song-
sters 
12:00 Duplicate Bridge 

2 
10:00 Yoga 
11-12 Blood Pres-
sure Screening 
12:00  Lunch at St. 
Matthew Church 
 
5:30 Social Service 
Commission at 
Trackside 

3 
9:30-11 Blood Pres-
sure Screening OH 

10:00  Jewelry 
Workshop 
12:00  Bridge 
1:30-3 Free Swim 
for Seniors Y 
 
 

 

6 
Newport Mansions, 
Newport, RI Trip 
10:30 Line Dancing 

11:30 Coffee and... 

12:30 Play Reading 
with Sherman 

7 
8:45  Water Color OH 

11 Yoga 

12 Garden Club Ac-
tivity and Lunch 
 

2:00  Chair Yoga OH 

8 
9:30 RSVP OH 
10 Tai Chi 

12  Lunch OH 
Guest:  Treblemakers 
 

9 
New York on-your-
own Trip 
 
10:00 Yoga 
12:00 Lunch 
12:45  Bingo 
 

10 
9:30  Basic Excel 
12 Parks and Rec 
Holiday Lunch 
12 Bridge 
1:30-3 Free Swim 
for Seniors Y 
 

13 
10:30 Line Dancing 

11:30 Coffee and... 

 

14 
8:45  Water Color OH 

9:30 Advanced 
Graphics 

11:00 Yoga 

1:00  Holiday Cookie 
Making compliments 
of Laurel Ridge 
2:00  Chair Yoga OH 

15 
9:00-10:30 Blood Pressure 
Screening Y 
9:30 RSVP OH 
10:00  Tai Chi 

10:00  Comstock Writers 

12:00  Lunch OH 
Guest:  Middlebrook Sing-
ers and Firefighters 
 

16 
9:30  Advanced 
Graphics 
10:00  Yoga 
11:45 Wilton Senior 
Council G 
No Lunch at the 
Senior Center 

17 
9:30  Basic Excel 

9:30-11:00 Blood 
Pressure Screening 
OH 

12 Bridge 
1:30-3 Free Swim 
for Seniors Y 
 
Hayrides Tonight 
at Ambler Farm 

20 
9:30  Introduction to 
Word 2007 

10:30 Line Dancing 

11:30 Coffee and... 

 
 

21 
18:45  Water Color 
OH 

0 Strength Train. Y 

10:30 Arthritis Ex. Y 
11 Yoga 

12:00 Duplicate 
Bridge 
2:00  Chair Yoga OH 

22 
9:30  Introduction to Word 
2007 

10 Tai Chi 

No Lunch at Ogden House 

23 
10:00 Yoga 
12:00 Lunch 
12:45  Bingo 

24 

Christmas Eve 

Senior Center 

Closed 

27 
10:30 Line Dancing 

11:30 Coffee and... 

1:00 Comstock Knitters 
and Crafters 

28 

8:45  Water Color OH 

11:00  Yoga 

12:30-2:00  Blood 
Pressure Screening 
VM 

2:00  Chair Yoga OH 

29 
9:30 RSVP Corridors As-
sembly OH 

10:00  Tai Chi 

No Lunch at Ogden House 

30 
10:00 Yoga 
12:00 Lunch 
12:45  Bingo 

31 
New Year’s Eve 
Senior Center 
Closed 

 

Corridors 
is on the 

Town website 
www.wiltonct.org 

 
Click on the miniature Corridors 

on the home page. Kiwanis Holiday Concert 

Dec. 4, 8 p.m. 



Page 8                                                                                                                                                                                                                    November-December 2010 

and Mini Toolbar. From the Page Layout tab, you 
will apply borders to pages, paragraphs, and text, 
and apply shading with custom color selections.  
From the Home tab you will insert graphic styles of 
bullets and numbering; from the Insert tab, utilize 
task panes, galleries and/or contextual tool tabs for 
Clipart, Pictures, Positioning of Pictures, Word Art, 
Symbols, Special Characters, and text boxes.   
(Guide and practice sheets included.) 
 
Advanced Graphics in Word 2007 
This course will build on the material learned in 
Word 2007 Graphics.  You will further enhance your 
subject matter in a document, simple table or col-
umns.  The Drawing function, with its many new fea-
tures, will be covered in depth.  You will move 
through the Layout Tab for margins and orientation, 
Home Tab for specific functions to insert text mate-
rial, and the Insert Tab to incorporate Word Art, Clip 
Art, Pictures, and Drawings.  (Guide and practice 
sheets included.) 
 
Basic Excel 
This two-session course will introduce the basics of 
this popular spreadsheet program including essen-
tial vocabulary, concepts and features.  Become fa-
miliar with entering, editing, and formatting numeri-
cal and text data.  Experiment with basic database 
capabilities.  Learn to design meaningful, attractive 
and useful spreadsheets. (Worksheets included.) 
 
Course Fees 
Each course listed above is $25.  The registration 
form is at www.wiltonct.org on page 13 of the Corri-
dors Newsletter.  Print it out and send it in! 

The Computer Learning Center offers computer 
classes specifically designed for adults.  Come and 
experience computer learning in a fun, stimulating 
and comfortable environment at the Senior Center. 
 
Introduction to Computer Fundamentals 
This introductory course is for those with limited or 
no computer experience who would like to test the 
waters.  It will include turning the computer on and 
off, using the mouse and keyboard, understanding 
the meaning of simple computer terms, opening and 
closing a program, and using the desktop.  This is 
excellent preparation for Introduction to Word 2007. 
 
Introduction to Word 2007 
Step into the present to acquaint yourself with the 
Word 2007 program.  It has a different appearance 
from the Word version you may have been using.  
The familiar toolbars and menus from previous ver-
sions of Word are gone!  This course will explore the 
Word Window, Office Button, Terminology, Ribbon 
Organization, Quick Access Toolbar, Document 
views, plus commonly used features in Word.  You 
will learn how to do the same things you’ve always 
done such as entering, changing, deleting, copying, 
pasting, underlining, aligning, saving, as well as in-
serting a bullet or number in text in a Word 2007 en-
vironment.  (Guide and practice sheets included.) 
 
Word 2007 Graphics featuring how to use the rib-
bon.  (Word 2007 familiarity needed.)  You will be 
amazed at what you can create!  A quick review will 
cover the Office Button, Terminology, Ribbon Or-
ganization, Office Clipboard, Quick Access Toolbar, 

COMSTOCK COMPUTER LEARNING CENTER 
 

COMSTOCK COMMUNITY CENTER 
180 School Road, Wilton 

203-834-6410 or 203-762-8445 
Andrea Ragusa, Coordinator 

COMPUTER CLASS SCHEDULE 

Classes take place from 9:30 a.m.-11:30 a.m. 
 

Introduction to Computer Fundamentals, Nov. 9 & 12 

Introduction to Word 2007, Dec. 20 & 22 

Word 2007 Graphics, Nov. 16 & 19 

Advanced Graphics in Word 2007, Dec. 14 & 16 

Basic Excel, Dec. 10 & 17 

COMPUTER CENTER  

INCLEMENT WEATHER POLICY 
When the Wilton Public Schools are closed due to 

weather, the Computer Center courses for that same 

day are cancelled. 

School DELAYS do not affect the computer courses. 

Call 203-834-6410 after 7 a.m. for information. 
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Volunteer for the nation’s largest FREE tax preparation 
and assistance service.  There are many kinds of vol-
unteer opportunities – from Tax-Aide Counselors to 
Greeters as well as Communications and Technology 
Coordinators.  One opportunity might be right for you! 
 
Like working with numbers? 
AARP Tax-Aide volunteer Counselors interact with cli-
ents by preparing tax returns on a one-to-one basis.  
Even if you don’t have accounting or tax preparation 
experience, becoming a Counselor may be right for 
you.  AARP provides training in tax law procedures, the 
preparation of tax forms, and the use of tax preparation 
software. 
 
Like working with people better than working with num-
bers? 
An AARP Tax-Aide Greeter is the first person clients 
meet when they enter a tax counseling facility.  Greet-
ers make sure the taxpayer has all the necessary pa-
perwork before meeting with a volunteer Counselor, 
and they manage the flow of clients being served. 
 
Have a knack for computers and technology? 
Technology Coordinators manage computer equip-
ment, work to ensure taxpayer data security, and pro-
vide technical assistance to volunteers at multiple sites 
on technology issues. 
 
Good at managing people and programs? 
Leadership Positions manage volunteers, synchronize 
plans with other volunteer leaders, and assure smooth 
program operation. 
 
FOR ADDITIONAL INFORMATION: Visi t 
www.aarp.org/taxaide. 

AARP TAX AIDE 2010 

 

Wilton Emergency Contact List 
 

To add your name to the Wilton Emergency 
Contact List, call Sharon Powers at the De-
partment of Social Services 203-834 6238.  

This list will be used  to identify Wilton sen-
iors who may need assistance in a natural 

disaster or other emergency. 

 

R.S.V.P. 

Holiday Boutique 

 

Wednesday, November 10 
11 a.m. - 1:00 p.m. 

Ogden House, 100 River Road, Wilton 
 

Proceeds buy needed supplies for hand-
crafted projects that are donated to the com-
munity.  The public is encouraged to attend. 
 

Why support the R.S.V.P. Boutique? 

In 1971 RSVP was launched under the 
auspices of the Federal Administration on Ag-
ing.  By 2001 the RSVP program nationwide 
included over 750 local projects with nearly half-
a-million volunteers contributing over 78 million 
hours of service through a network of 70,000 
local agencies.  What started out as a small fed-
eral project more than 35 years ago has be-
come an integral part of many communities na-
tionwide. 

Wilton volunteers contributed 6,945 hours 
of time to the community in the past year.  This 
volunteer service helped augment staff time in 
various agencies and assisted in needed fund-
raising.  Service hours included administration 
assistance, help with special events, educa-
tional programs, flu clinics, blood mobiles, kin-
dergarten registration, and emergency prepar-
edness training. 

The Wilton volunteers also created over 
350 hand-crafted items which were donated to 
Social Service agencies in Wilton and those in 
need in the greater Southwestern Connecticut 
community.  Items included lap robes to Wilton 
Social Services; bibs to the Department of Men-
tal Retardation of Lower Fairfield Regional Cen-
ter; hats, mittens, and scarves to the NEON 
Child Development program; quilts to Family 
and Children’s Agency and Nursing and Home 
Care/Mid-Fairfield Hospice.  Hats and scarves 
were donated to the Merchant Seaman’s Christ-
mas at Sea Project. 

 



Meals on Wheels of Wilton is a not-for-profit or-
ganization which serves our community by pro-
viding nourishing meals for those Wilton resi-
dents of any age who are not able to take care 
of their own nutritional needs because they are 
sick, homebound, handicapped, convalescing, 
frail, or for any other reason. 
 
Dedicated volunteers deliver a hot and/or cold 
meal at noontime every Monday, Wednesday, 
and Friday.  Double meals may be delivered to 
those clients requiring prepared food six days a 
week.  Low fat, low salt, and other special diets 
are prepared by the dietary staff of Wilton 
Meadows Health Care Center in accordance 
with individual health wishes and/or instructions 
from physicians. 
 
The current fee is $3.50 per hot meal and $1.75 
per cold meal.  No one is refused because of 

financial reasons.  We encourage referrals from 
physicians and other health professionals.  We 
welcome inquiries from anyone who may need 
our service and from  relatives, friends, or 
neighbors.  While we request 24-hour notice to 
begin or stop service, we are here to assist cli-
ents on either a short- or long-term basis. 
 
Devoted volunteers are the integral foundation 
of our organization.  Most drivers deliver once a 
month, but some are on our substitute list and 
deliver only occasionally.  If you are interested 
in volunteering for this worthwhile effort, or if 
you would like to request meal delivery, contact 
coordinator Janet Kristiansen at 203-762-0566 
or 203-762-7861. 
 
If you have other questions or are interested in 
serving as a Board member, please call 
Jeannie Bain at 203-762-3192. 
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MEALS ON WHEELS OF WILTON, INC. 
by Jeannie Bain, President 

society.  Desdemona is a lady from the best society 
of Venice who has eloped in the night to marry a 
stranger, Othello.  Iago, a professional soldier serv-
ing under Othello, is one of Shakespeare's most 
subtle villains.  For revenge, Iago brings Desde-
mona and Othello to destruction by drawing upon 
the jealousy in love. 
 

Coming in 2011: 
January 10, Othello (Part 2) 
 by William Shakespeare 
February 7, She Stoops to Conquer 
 by Oliver Goldsmith 
March 7, Androcles and The Lion 
 by George Bernard Shaw 
April 4, The Bourgeois Gentleman 
 by Moliere 
May 2, Cat On A Hot Tin Roof 
 by Tennessee Williams 
 

Call the Senior Center at 203-834-6240 to sign up. 

Play Reading 

 

Monday, November 1, 12:30 p.m. to 2:30 p.m. 
Moderator—Andrea Ragusa 
Design For Murder by George Betson 
 
This exciting thriller in three acts is 
about Celia Granger and her ef-
forts to maintain the traditions at-
tached to her family’s magnificent 
old mansion on the Hudson River.  
Suddenly a young maid is killed and Celia finds her-
self living in a violent setting.  When the chauffeur 
stumbles upon information linking Celia’s son to the 
slain girl, suspicion falls on everyone. 
 
Monday, December 6, 12:30 p.m. to 2:30 p.m. 
Moderator—Sherman Poultney 
Othello by William Shakespeare (Part I) 
 
―The Tragedy of Othello, the Moor of Venice‖ is per-
haps Shakespeare's greatest triumph as a stage 
play.  Othello is a man of royal blood and a profes-
sional soldier, but he is not experienced with life in 



 

BOOK DISCUSSION with RAY RAUTH 

at the Senior Center 

Tuesday, November 23 
 

Life on the Mississippi by Mark Twain 
 

This is no ordinary travel book.  On April 18, 1882, 
Mark Twain together with his publisher, James R. Os-
good, and Roswell Phelps, a stenographer, began the 
journey to the Mississippi.  They traveled by rail cover-
ing the thousand miles from New York to St. Louis in a 
day and a half and took four hours in a little packet 
boat to make the one-mile trip across the river to East 
St. Louis and into a different civilization.  According to 
the book’s introduction:  ―The juxtaposition of the two 
civilizations connected by the drifting river was…a 
metaphor expressing Mark Twain’s contradictory 
imagination.    A child of progress who had committed 
himself to the technology of steam, to the American 
ideology of freedom and progress, and to the Ameri-
can business of finance capitalism…yet could fully feel 
the pleasure and indulgence of idleness, lost time, and 
even lost cause.‖ 
 

Discussion at 11:00 a.m.; lunch ($3) at noon. 
Call 203-834-6240 for reservations. 
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Holiday Cookie 

Decorating Party 
Mark your calendar for a  
sweet date on Tuesday, 
December 14, from 
1:00 p.m. to 2:00 p.m. 
at the Senior Center's 
Holiday Cookie Decorat-
ing Party compliments of 
Laurel Ridge Health 
Care Center of Ridge-
field.  Please join us 
while we listen to holi-
day music as we frost 
and decorate cookies.  Laurel Ridge will provide the 
cookies, decorative toppings, and icing.  All you 
need to bring is your creativity!  Space is limited to 
the first 20 who sign up.  Reservations required:  
203-834-6240 

THE GREENS AT 
CANNONDALE 

 
The Greens at Cannon-
dale in conjunction with 
Danbury Hospital has 

two exciting presentations for November. 

On Thursday, November 4, Dr. Frank Hermantin of 
Danbury Orthopedic Associates will present ―Life is 
Not a Spectator Sport!‖  With modern medicine and 
increasing options for continued bone and joint 
health, you never need to become a spectator in the 
game of life.  Learn how to keep yourself healthy, 
with unique ways you can strengthen your bones 
and body by keeping yourself active. 

On Thursday, November 11, Stroke Program Coor-
dinator Heather Duggan, RN, will present ―A Stroke 
is Not Par for The Course!‖ You don’t have to be a 
pro to reduce your risk of a stroke. Learn how to 
recognize the hazards and warning signs of a 
stroke. Take home tips on preventive care and un-
derstand how to keep your body ―young at heart.‖ 
 
A light dinner will be provided at 5:30 p.m.  Presen-
tations will take place from 6:00 p.m. to 7:00 p.m. at 
The Greens at Cannondale, 435 Danbury Road, 
Wilton.  Please call 866-374-0007 for reservations. 

STAY at HOME 

in  Wilton  

Stay at Home in Wilton is providing seniors of all 
ages assistance with the things they need to stay in 
the homes they love.  If a ride is needed, we have 
volunteer drivers.  If a computer is misbehaving, we 
have competent computer geeks among our volun-
teers.  If you would like to meet other members of 
Stay at Home in Wilton, there are opportunities to 
meet and greet, and be involved.  Just watch the 
local papers. 
 
To find out more about Stay at Home events and 
offers, please go to www.stayathomeinwilton.org  
(Yes, we know it’s a long name for a website, but no 
one else has it!)  The website includes information 
about joining, the various services offered, and how 
to contact someone who can answer your questions 
at info@shwil.org  

http://www.stayathomeinwilton.org/
mailto:info@shwil.org


 

 

Kiwanis Club of Wilton 
 

presents 
 

The Big Band 

Holiday Concert 
  

Saturday, December 4, at 8 p.m. 
Wilton High School Clune Center 

  

featuring 

The Fairfield Counts 
  

General Admission - $20 

Call Dial-A-Ride today to reserve your ride. 

Seats are limited.  Call 203-834-6235.  

  

To order tickets:  203-604-9014 or 

www.wiltonkiwanis.org 
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Catherine Pierce ............................ 203-834-6238 
Director, Social Services, and Municipal Agent for the Elderly 
 

Lauren Hughes .............................. 203-834-6238 
Coordinator, Senior Services 
 

Lizabeth Doty ................................. 203-834-6240 
Coordinator, Senior Activities 
 

Andrea Ragusa .. 203-762-8445 or 203-834-6410 
Comstock Computer Learning Center 
 

Sharon Powers .............................. 203-834-6238 
Office Assistant 
 

Meals-on-Wheels ........................... 203-762-0566 
Dial-A-Ride ..................................... 203-834-6235 
Town-to-Town ................................ 203-299-5180 
FISH (medical transportation) ...... 203-834-3737 
AARP .............................................. 203-866-0435 
RUOK (Are You OK?) 203-834-6238 or 834-6260 
Visiting Nurse & Hospice of Fairfield County .... 
 ........................................................ 203-762-8958 
Parks and Rec Department ........... 203-834-6234 
Wilton Family Y .............................. 203-762-8384 
Wilton Library ................................ 203-762-3950 

Printing costs for this issue of 

Corridors have been 

 generously underwritten by 

“The Area’s Premier Assisted Living Community” 

435 Danbury Road, Wilton, CT  06897 



COMSTOCK COMPUTER 
LEARNING CENTER 

COMSTOCK COMMUNITY CENTER 
180 School Road, Wilton, CT 06897 

203-834-6410 or 203-762-8445 
Andrea Ragusa, Coordinator 

 
The Computer Learning Center in Comstock Community Center offers computer courses for adults.  
Course descriptions are published in The Wilton Bulletin, the Parks and Rec Fall Brochure, and on 
the website at www.wiltonct.org.  To register please print this form and send it in with your check. 

Mail the form below and your check payable to TOWN OF WILTON to: 
Comstock Computer Learning Center, Comstock Community Center, 
180 School Road, Wilton, CT 06897 
 
Name:_____________________________________________________________________ 
 
Address:____________________________________________________________________ 
 
Phone: _________________________________________________________________ 
 
E-Mail: ____________________________________________________________ 

 

X COURSE TITLE DATES Fee 

  INTRODUCTION TO COMPUTER FUNDAMENTALS November 9 and 12 $25 

 INTRODUCTION TO WORD 2007 December 20 and 22 $25 

  WORD 2007 GRAPHICS November 16 and 19 $25 

 ADVANCED GRAPHICS IN WORD 2007 December 14 and 16 $25 

 BASIC EXCEL December 10 and 17 $25 


